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» Specify Projection
» Customizing Projection

» Changing Projection
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#! view Properties

Mame: | View?2
Creation D ate: |09 nsngew 2004 09:43:33 Cancel |
Creataor:

I
tMap LS| decimal degrees q
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Frojectis klone

Projection.

Background Color: ﬁ

Comments:

Area OFf Inkerest... I

¥ Projection Properties

&+ Standard " Custom

Cancel

M Category: [ UTH - 1333
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Tepe: | Zone 43

Projection: Transverze Mercator
Spheroid: GRS B0

Central Mernidian: 105

Reference Latitude: 0

Scale Factor: 0.3396

Falze E asting: 500000

Falze Marthing: [
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» From the View Menu, Choose Properties

)

Geoinformatics Center

sian Institute of Technology

! ¥Yiew Properties |

[View? T

I ame:

Creation Drate: | 09 Aisngves 2004 09:43:33

Creator: |
Map Units: | decimal degrees B3|
Diztance Units: | kilometers E3|
Projection: Mohe

Frojection. .. | Area OF Interest. . |
Background Calar: ﬁ Select Color... |

Comrments:

If a projection has already been set, the name of the projection will

appear. If no projection is currently specified for the view, set the Map

Units to decimal degree for the projection to work correctly.
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Name: [ViewZ

Creation D ate: | 09 asngiau 2004 09:43:33

> Click the Projection ™'

Map Urits: [ dacimal degrees

Distance Units: [kilometers

> Select Custom

Projection: Transverse Mercator
Spheroid: GRS 80

Central Meridian: 105
Reference Latitude: O

Scale Factor: 0.9996

False Northing: 500000

False Easting: O

File  Edi

Broperties...

Window Help

Bt Mew Theme...
Themes On
Themes Off
Layout...
TOC Style....
Full Ezstent

Zoom |n
Zoorm Qut

Zoom To Themes

[Geocode Addresses...
Add Event Theme...

Zoom To Selected

Zoom Preyious

Eind...
LLocate Addiess..

Cil+F

X E

-

Scale 1: 2.076,461
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#! Projection Properties

= Standard

f* Custom

Frajection: | Transverse Mercator

Spheraid: §

Central Meridian:
Reference Latitude:
Scale Factar:

Falze E asting:

Falze Horthing:

105. 7656734058
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The ArcView Projection Utility -- Project shapefile from one coordinate system to another

and save it as a new Shape file

42 Arcview GIS 3.2a 1ol x|
Edit “iew Theme Graphice ‘window Help
SAAEIEIE) D
= (7] |

=TI Scake 1[Z.076.461 TEET &
|

Set Working Directory...
Save Project Chl+5

» From the File Menu, Extension

x

Awailable Extengions: —

e A ]
e CEE T — == | % Click Projection Utility Wizard

_ | Spatial Analyst

_| TIFF B.0Image Support J Reset |

| “ector Conversionsz Extension [1.1) ™ Make Defaul
| WPF Viewer LI

About:




» From the File View Window,
Add theme “district.shp”

i ArcWiew GIS 3.2a

' Edit  Miew Theme Grap
Lloze

Cloze Al

Set Working Directary. ..
Save Project Chil+5
Save Project ds.

E stensionz...

Erint...
Frint Setup...

£} ArcView GIS 3.2a

File Edt Miew Thems Graphicz “Window Help
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=10l x|

& ¥iewl

+] Districtshp

ol

S
I}

Bot. » From File Menu, Select ArcView Projection Utility
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* prc¥iew Projection Utility - Step 1 =101

Select which shapefile(s) vou would like to reproject inko another coordinate swystem, IF
rultiple files are specified, they must exist in the same directory and be in the same

coordinate syskem. > Browse “ Shape flle" yOU

Direckary
d:training_july2004 ‘ Browse, .. > . .
Marne | Sizel Type | Counk | Coordinate SE AT Want to Change the prOJeCtlon

(district.shp)
» Click Next

4| | i3

0 Fileds)

Help I Cancel | < Back Tk, =

= Arc¥iew Projection Ukility - Step 1 =01 x|

Select which shapefileis) vou would like to reproject into another coordinate system, IF
mulkiple files are specified, they must exist in the same direckary and be in the same
coordinake system,

— Directary
d: Y training_july 2004 inkro-aw

Marne | Size | Twpe | Caunk | Coordinate Syskem |
[ district. shp 9O0KE  POLYGON 15 unknown

The File has been selected will appear

4| | i

1 fileis)

Help | Cancel I < Back Mexk = I
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what is the current coordinate syskem of wour shapefileis)?

[~ Shaw Advanced Options

Mame |

|'Cu:u:|rdinateSvstemType— > SpeCIfy Current COOl’dlnate System

{* Geographic

> WGS_ 1984

» Unit as Degree
» Click Next

Units
IDegree [9102] j
0.017455292519943

Help | Cancel < Back | Mext = I

Arc¥iew Projection Ukility |

You have just specified a coordinate syskem For wour shapefile(s), would vou like to save the coordinate syskem information now? Press Yes ko
save this new information with vour input shapefileds).

= ArcYiew Projection Utility - Step 3 o ] oA |
Mo | ) ;
Select the new coordinate swstem For your new shapefilels),

[~ Show &dvanced Cptions

Mame

Coordinate Svs

(¥ Projected

» Specify New Coordinate system

Mame

[wGs_1984_UTM_Zane_4an [32648]

» WGS 1984 Zone48

Units
[Meter [a001]
1.0

Factor:

> Unit as Meter

> Cl I C k N ext Help | Cancel < Back
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“** ArcYiew Projection Ukility - Skep 4 =150 ]

Where do vou want to save vour shapefileis)? IF multiple files were specified, the new
shapefiles must be writken to a direckory different than the ariginal directarsy,

» Browse directory where you want to

| Browse. ..

Mew shapefile name
di'schoaliNewshape shp |

save your file

(d:\training\district_prj.shp)

Help | Cancel < Back Mext =

Saveas 21|
Save in: Ia Training_July 2004 j & EF v

| Inkro-ay

| Presentation
gepsatimg.shp

-
L

tdy Documents

Filz name: Idistrict_prolshp j Save I
j Cancel |
p

Save as bype: I shapefile [*.3hp)
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i prc¥iew Projection Utility - Step 4 =iol=| > Cl | C k S ave

Where do you want to save your shapefiles)? I multiple files were specified, the new
shapefiles must be written to a directory different than the original directary.

» Then Next

Mew shapefile name
ds\braining_july2004 district_proj.shp

» ArcView Projection Utility Summary

Page will appear

» Finish

= ArcYiew Projection Ukility - Summary - |I:I|5|

Help | Zancel < Back Mext > DWW Please vetify the following settings are correck. Then, press the Finish bukkon Eo
begin reprojecting the listed shapefile(s).

Input directory and file name (s): -
ditraining julyZ004)\intro-aw
district. shp

Input Coordinate System:

Name - GCE_TGES_1924
POsSC: 42E6
Uitz Degres
Datiam: I WGS 1354
Prime Meridiamn: Greenwich

Input Geographic Transformation:
none

Output Geographic Trawnsformatiorn:

£ ArcView Projection Ukility - Complete - | I:Ilﬂ

Help I Prink I Cancel = Back

Finished processing wour shapefiles.




» Add theme (district_proj.shp)
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A1 Arc¥iew GIS 3.2a

Eile Edit Miew TIheme Graphics

- ---

find o ]:lelp

=100 x|

Scale 1] 2.076.461 104.83 H

?' 23

« Ditrictshp H‘
-

Drirechany:
B district_proj.zhp =
B gocpzatimg. shp &= training_july20
£ imtro-av
£ presentatio
=
Drata Source Types: Drives:
| Feature Data Source =l |4

n4

& Arcview GIS 3.Za
Elle

Edlt Miew Theme Graphics ‘wfindow Help

i Viewl

ﬂ District_projshp -
/

4]

£41.953.19 <
1.916559.48 t

_ 5] x]
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Raster to Vector
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»Geometric Correction

> Raster to Vector conversion
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Assume you have Satellite image as a base and you need to create data from scanned map, now

you have to set geocorrection for your scanned map in order to work with other data layers.

Extension: Image to Map World File Creator uses to register the coordinate system with

Ground Control Point

. Scanned Map = --------- Image to be rectified
. Landsat Image --------- Based Map
lll.  GCP from map to be rectified as “gcpmap.txt”

V. GCP from Based Map as “gcpsatimg.txt”
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Howt get 6P ramthemep ="

FYIl. Read the coordinate on View Window and save in notepad as txt file

The marks will be the same point on both map need to be rectified and based map

=Tk
EI|E Edlt L{lew lheme ﬁraphlcs &Mlndow tleID
.; : 3 Soale 1 |— LdpEEEa & gcpmap.tst - Notepad

Fil= Edit Faormat Help

o X_TIC Y_TIC

100 2059.85 3520.25
102 6310.85 3520.25
103 2059, 85 2104.80
104 6310.85 2104.80
105 4884, 85 3520.25
106 3477.85 2104.80

Leglndnw Hel ||:|
Scale 1| 8 gg Qec 4t o ﬂgcpsatimg.tut - Motepad
=

File Edit Formak Help

I8 W_TIC ¥_TIC

111 500000 1850000
112 650000 1850000
113 500000 1800000
114 a50000 1800000
115 aooo00 1850000
116 550000 1800000

] Tm_swkoodizo.ti =

o=
35

FYI: Nothing to do with this slide, gcpmap.txt and gcpsatimg.txt are in d:\training_july2004



» From the File Menu, Extension

#1 Extensions il

Available Ertensions:

MrSID Image Suppart

2l oK ]
Cancel |

J oot |

™ Make Default

MITF Image Suppart

Frojection Utility \wWizard

Image to Map Wworld File Creator
World File erzeugen

Report Wiiter

Smartimage Evaluation +3.02 ﬂ

LLLH®LLL

About;

i Arc¥iew GIS 3.2a
Edit  Miew Theme Graphics Window Help
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=10l

Cloze &l

Scale 1:| H ?

Set Working Directany...
Save Project Chrl+5

Save Project &s...

e

Frint Setup...
Eppart...

tManage Data Sources...

Esit
T
Charl

&

LayaL

Sciip —

Cloges the active component

» Click Image to Map World File Creator



& ArcView GIS 3.2a
File  Project  Window Help

&2 Untitled Pt

» Go to Directory that you stored file
» Click gcpsatimg.txt)

7 gcpsatimig.txt
A

111 (500000 (1350000 L[]
112 1650000 (1850000
113 (500000 :1300000
114 {E50000 :1300000
115 {E00000 : 1350000
116 (550000 1300000

Geoinformatics Center

. Asian Institute of Technology

» Make Project Window Active

» Select Table Icon

» Click Add Button to Add
“gcpsatimg.txt” (based map)

» Select File Type from List Files of
Type as Text

&} Add Table =]
File Mame: Directories: K |
| d:straining_july2004
01 gepmap. bt A = d - ﬂl
B gopsatimg. b=t & training july2004

£ intro-ay

£ presentation

-

1zt Files of Type: \ Diives:
| Delimited Test [* tat] j [ =1
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il Arc¥iew GIS 3.2a
Eile  Fropect  Window Help

EINIE

» Make Project Window Active

» Select New View

& ArcWiew GIS 3.2a
Eile Edit WS Theme  Graphic:  Window  Help

B
fidd Theme...  CtileT

Add Event Theme...

Themes Ok
Themes OFF

L4]

-
—

[Layout...

TOC Shyle...
Full Egtent

oo

. . 2o [k
» Go to View Menu, Click Add Event Theme Zom Tia Thermes
oo a Selected

oo Preyaus

EirdL.. [Ctrl+E

Locate Sddress...

id ||

e o R R m:ﬁ\!r{\”

(]




Geoinformatics Center

Asian Institute of Technology

! Add Event Theme 5'

> Select

» Table as gcpsatimg.txt

| qopsatimg. bkt

» X field: X _tic

field: |, tic

> Y field: Y_tic

Y fiigld: I‘f tic

i ArcYiew GIS 3.2a - |01 x|

El Edt &iew Ih eme ﬁ ph &3{ d ows  Hel Ip
T & T Seale 1|—

B37 77174 o
185185326 ¢

ﬂ Gepsatimg txt

ak. I Cancel |

» Point correspond to X, Y

Coordinate will appear in View

L«
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i ArcYiew GIS 3.2a
Ele Edt ¥iew Graphics  window  Help
+ @ Eroperties...
0 Start Editing
Save Edits

Edit Legand...

Hide/Show Legend .

» Go to Theme Menu, Click Convert
Autolabel... Chil+L

Femove Labels [Ctrl+F

Femove Overlapping Labels to S h ap efi I e

Canwvert Oyverlapping Labels Chrid

Table...

Luery... Chil+Q
Select By Theme...

Lreate Buffers...

Clear Selected Eeatures

I

i} Convert Gepsatimg.bxt

= dh N Cancel

Xl
Directanes:;
e I]:4
gopzatimg. shp d:\braining,_july2004 4'

& training_julv2004
£ intro-av

[0 presentation

» Save as gcpsatimg.shp

» Click OK

Drives:
» Close all o 3

Note: Check Point with Coordinate System on the View whether it is correct



I ArcView GIS 3.2a i m]
Eile Project 'window Help
< Untitled
#! Extensions x|
Fallable Extensions:
| Projestion Uity Wizard B
1 Image to Map World File Creatar
] Cancel I
| ‘“World File erzeugen
| Report Writer
| Smartimage Ewaluation v3.02 J Hesst I
_| Spatial Analyzt ™ Make Default
1 TIFF 6.0 Image Suppart j
Scripts E
iy
=

> Click [#]

Geoinformatics Center
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» Open New Project

» Go to File, Extension check
» Image to Map World File Creator
» TIFF

i@ Arc¥iew GIS 3.2a

=lox|

I
a
=
-
Ll
Ll
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. . ile M ame: Directories:
> Dialog will appear, Select the ( [ > S, _ x|

a0z, gl " : — Cancel
map that you want to change D1 foas - T

i
the coordinate (river.tif) N J £ presentaion
B tm svk tw
0
B

Drrivves:
| d =l
i =] |
Eile Edit Miew Theme Graphicz Window Help
B (3] BN B0 PR
ENEIENE EE iR iy

) Image to be Rectified

ml—I I—_

| .
i DII’ECEIDFIES. . oK. | 1=
d:Mraining_july2004
B ogopsatimag.shp -

» Select Point shapefile (gcpsatimg.shp) S e

£3 presentation

List Files af Type: Dirives:

| ShapeFils 2 I B3|
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d:htraining,_july2004

- (= d*

X
Drirectaries: 0K |

Cancel

&= training_july=004

£ intro-av

£ presentation

» Save as xyz.dbf
» Click OK

& ArcView GIS 3.2a
Eil=  Edit Miew Theme Graphics indow Help

A FHIEIE
el ETaRETE[Z s <IT et G SARREY

#! Image to be Rectified ) Registration Map

+*

ﬂ R i e 1 tif = ﬂ Gepsatimg.shp =l
[ ]

|5
[
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» From Image to be Rectified -lojx]

File Edit Miew Theme Graphics “indow Help

_ _ . 7 BEI< ¥ Bl &
View. Click to pick BRI
Ground Control Point 7 o N

_ 7 05a 54
Scale 1 §5%085 ¥

72 Registration Map

ﬂ Gepsatimg.shp ]
L ]

» Go to First Point and click

at the point
» From Dialog, Click Yes

Do pou veant to keep the point pou just
enterad 7

2 Arc¥iew GIS 3.2a =10l

Eil=  Edit Miew Theme Graphics Window Help
R [
ERCIDN S E E R RS R Scde 1] 1 7SR E8 ¥

& Registration Map

72 Image to be Rectified

| Rivertit I o] Gopsatimashp |2
L]

» Red Spot will appear
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i Arcview GIS 3.2a ol x]
> O O O File Edt Miew Theme Graphicz ‘wWindow Help
€10 10 REGISTEIO) VISH SEFIHEE B0

R E NN SN EA ETRE W VR Sede 1 RS ¢

Click to pick Ground

Control Point

|»

ﬂ Gepsatimg.shp
L]

» Go to First Point and click
at the point
» From Dialog, Click Yes

Ll

» Red Spot will appear

@ ArcYiew GIS 3.2a =10[ |

Eile Edit Miew Iheme [Graphics window Help
2] FEEEE] E

Scale 1] 1958 70 ¢
-

2 Registration Map

#] Gepsatimg.shp =l
L ]




Geoinformatics Center
- IDIﬂ Asian Institute of Technology

! Arc¥iew GIS 3.2a
Eile Edit Miew TIheme Graphicz findow Help

EODNNE R RN E RN

Scale 1] et

L]
T

» finish 6 points on

1 Image to be Rectified #! Registration Map
ﬂ B i e tif = ﬂ Gopsatimg.shp = .
- both Views
A _ . . .
.-'l__:.
o
. . .
1

~=lolx|

& ArcYiew GIS 3.2a
Eile Pmoject indow Help

- =
#! Untitled
Mew | Open | Add
@ Al Ground Control Poinks
iEws

» Then Minimize views and Open

Ground Control Points table

4]
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i Arcyiew GIS 3.2a =10l x|
Bt Table Field Window Help
_ EIRE
» Ground Control Points table appear, Do kot [x D]
#! Ground Control Points
. Lze Point Inpuit = Input v Output » Clutput y
C||Ck ‘E o Calculate RMS Value iy 2080.33 2506.41 43335395 1849333.29 0.00 [4]
ON E310.81 250E. 34 £43333 88 1850000. 01 0.an
ON 2053.71 332235 433333 93 180000000 0.an
> Total RMS value will appear, Click Ok = e t
ON 377 B4 332318 55000000 180000000 0.an
£ Arc¥iew GIS 3.2a ol x|
Eile Edit Table Field “indow Help
| 0 u:uf| B zelected “ -
#1 Ground Control Points et
|Jze Point Input « Input » COutput » Output v RS
2060, 33 250641 49333395 1849339 83 98,08 |
E310.81 2506, 34 E43393,83 1850000.01 126,65
205371 392235 493333,399 1280000000 34,48
5310.80 3322.25 ER0000.00 180000000 20.05
i< Total RMS || #2473
3 25,75
0 The total BMS value iz 529.8 > You Ca-n aISO edlt the
point to less the error
i} Attention! x|

-
‘l Ilnl ||

MHaow pou can delete the records that have high RMS walues
fram the Ground Contol Points T able and then recalculate the
RS values.

o




» IF you satisfy the error, Click
0] to write the file to disk
» Dialog appear, Click Yes

Lo pou want ko write the Y orld file?

» Specify File name “river. TFW”

» Click OK

! Attention

cloze. Yiou can uze the new registered image by adding it to a
FIEA IS,

O The "arld file iz now written and the current project will now

i Arcview GIS 3.2a
dit Table

Field Window Help

=0l x|

E zelected

INEY]

72 Image to be Rectified

! Ground Control Points

] Riverti

|»

Output y RS
1649939.89 98.08 =
1850000.01 126.65
1800000.00 34.48
1800000.00 20.05
1850000.04 22479
1800000.00 25.75

72 Registration Map

ﬂ Gepsatimg.shp
L ]

|

i} Specify file

Filz Mare: Directories:
| river. TP d: hraining_july2004
- (= d* -

L]

&= training_july2004
£ intro-av

£ presentation
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# Attention x|y

cloze. You can use the new registered image by adding it to a

O The *world file iz now written and the current project will now
g g,

» The Dialog appear, confirmed --- Click OK

Your “tif file” will be ready to open as the coordinate system that you specified

#! Add Theme x|

o Dlirectory: |d:\training_iul}l2004 ok

» Open New View e N o — —'le
tr_ gk bl &= training_juiy200¢
» Add theme = ey B memon
& Dirsctories
» Select Data Source type “Image Data Source” = 5| s
Data Source Types: Drives:

» Select “river.tif” inage Dala Souace o =
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Projected Image

] 435 318,62
Scale 'I.I &553,85?,38 ?

ﬂ Savanakhetzhp |2

| Rivertif

| Tm_svkOD 1129, tif

aR

I

et e . -

L«]
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Raster ToOUEioR Camersion

This process we will use the projected scanned image from

previous steps as input file to be covert to vector file.

-Open new view,
Add image “river.tiff”

-Check box in Spatial Analysist
At Extensions in File menu

Available Extenzions:

_ | Repaort 'Writer
| Theme Snapping Tools
ﬂ Spatial Analyst

[~ Make Default
| ¥Tools 641,/01

About:

+]  Image ta Map Warld File Creator ﬂ (k. I
Cancel |

<] TIFF 5.0 Image Suppart J Reset |

& view1




-Activate “River.tiff”, select
Covert to Grid in Theme menu
-Save new grid file name “river-g”
at your working directory

-Click OK

#} Convert River.tif

i Arc¥iew GIS 3.3
Eile  Edit Miew &nalysis  Swface Graphiczs |

@ Eroperties...
&

'
- m R Start Editing

Grid Name Diirectonies:

[ iver-g d:traiting2 004 miniproject

| v

= training2004

&= miniproject

£ pl26i4a
£ p126i49
0 p127148
£ p127149

Ll

Diives:

Cancel |

= dn =~

Save Edits
Sawve Edite Az,

Conwvert ta Shapefile,..

Corvert to Grid....
Sawe Data Sel..

Edit Leqgend...
Hide/Show Legend

He-matzh Addresses.

71t LI

Id =]

-Open attribute table
of “river-g” and click
Select at “0” value

&! Attributes OF River-g [

[
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dnalysis  Suface  Graphics

-Select Convert to Shapefile 7 poics.
In Theme menu e

Save Edite bz,

Corvvert to Shapefile. .

#2 Convert River-g | I Caorreert to Grid...

File: Mame: Directories: oK | i Saye [Mata Set...
d:Mraining 20044 miniproject

| riveer1
(= d - Cancel |
[= training2004
&= miniproject

1 infa ﬂ’ gem.shp el
£ p12648
8 p126rd3 | Riwerztif
0O p12748 | . N . .
1 0127143 i ] Rﬁg,_g

Drives: L]+

oD ata
[d =]

-Define a new shape file’s name __
In the working directory 2 0 g ¢
-Add the new theme and display

Led




